































	Home
	Mac OS
	iPhone
	iPad
	Tips & Tricks
	News
	iOS
	Troubleshooting
	
	




































How to Join Multiple PDF Files Into a Single PDF Document in Mac OS X




Jun 27, 2014 - 47 Comments










If you have multiple PDF files that you want to combine into a single PDF file, you can rely on the Macs bundled Preview app to accomplish this. Not only can Preview combine a variety of single or multi-page PDF docs into a single file, you can even add images as pages, remove a page from an existing file if it’s unnecessary to have in the joined doc, or rearrange the pages of the joined files to be reordered according to your needs. The end result will be a single merged PDF document that contains every page and input file that you need.



Some apps make this task overly complicated, but Preview makes combining the highly portable and multi-platform pdf files incredibly simple, offering drag & drop ease. Perhaps best of all, you certainly don’t need to pay big extra bucks for a fancy PDF editor application when the Mac has the tools directly within Mac OS X. That’s what we’re covering here, with a step by step guide showing you how to quickly join a variety of these docs into a single file.

Combining Several PDF Files Into a Single PDF using Mac Preview

This will demonstrate combining multiple files, adding additional files, removing pages, reordering pages, and exporting as a single merged .pdf file of all the joined contents:

	Open one of the PDF files into the Preview app of Mac OS X
	Click on the Thumbnails button and choose “Thumbnails” to open the side drawer of PDF pages (do this even if one of the PDF files is only a single page length) – this can also be accessed from the “View” menu by choosing “Thumbnails”




	Now go to the Mac Finder and locate the additional PDF file you want to join to the one that is already opened in Preview app
	Drag and drop the additional PDF file from the Finder into the Thumbnail drawer of Preview app to instantly add it to the PDF – this adds the dropped PDF’s into the already open PDF doc, effectively combining them. You can repeat this with as many other PDF documents as necessary




	To add an image file as a page, simply drag an image file into the Thumbnail drawer
	To reorder the pages of the combined PDF, simply drag and drop them within the Thumbnail drawer to their appropriate position
	To remove a page, simply select it and hit the “delete” key to drop it


	When finished adjusting, pull down the “File” menu and choose one of the following depending on version of Mac OS X:
	 “Print”, then choose “Save as PDF” – this works in MacOS Catalina, Mojave, High Sierra, El Capitan, Yosemite, Mavericks
	 “Export as PDF”  (normal saving does not work reliably to join the PDF files together, this is likely a bug) – works in prior releases of Mac OS X






	Save the new file as usual (optionally, you can encrypt the document if desired with password protection), and exit Preview when done




You can always double-check that it worked by re-launching the freshly created PDF document that you just exported from Preview app, it will contain all of the PDF files that you dragged & dropped into the Thumbnails app to join them.




That’s all there is to it, remarkably simple, and it’s free and universally supported (for Macs anyway) since Preview is bundled in every single version of Mac OS X. This is by far the best way to merge PDF files on the Mac.

One thing to note about older versions of Preview app is the “Export to PDF” option is not always available, thus these older versions of Preview can still successfully export the combined files as one either by choosing the “Save As” option, or by using the traditional Print to PDF option that is available through the Print menu in all versions of Mac OS.

Quick side note: joined PDF’s can often be quite large, if the resulting file is too large you can reduce the file size by adjusting the Quartz filter used. While this reduces the file size, it can also reduce the quality of the images and artwork within a document, so it’s best used for text heavy docs where image sharpness doesn’t matter as much.

Have any questions or comments about merging multiple PDF files into a single PDF document? Let us know in the comments.
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						Nobita says:		

		
		
			February 16, 2021 at 10:33 am		


		I have Mac Sierra 10.12.6 from 2012. I can confirm that this method (Preview + Thumbnail + Drag and Drop + Print => Save) works beautifully on my Mac as of 2021.

They work for either two single pdf files or multi-pages pdf files. They will be combined into ONE single file and this file is a NEW file, separately from the original files.


		Reply

				

				
	
				
				
						Jean says:		

		
		
			December 5, 2017 at 3:44 pm		


		Hi I just did this with the print as pdf method. It worked ok but the quality of the final grouped pdf is of much lesser quality. It is blurry… Does someone have any idea what is wrong ?

Thanks!

Jean


		Reply

				

					
				
				
						Jean says:		

		
		
			December 5, 2017 at 3:50 pm		


		Just realized I was using jpg’s. But the quality resulting pdf is so bad it is not a pleasure to use. I am printing music.


		Reply

				

				



	
				
				
						Lindsay says:		

		
		
			April 6, 2017 at 4:25 pm		


		I was able to get all my PDFs into preview, but no matter which way i try to save it, it saves it as all separate, or just one of the pdfs rather than keeping it all together as i have in preview!

Help!


		Reply

				

					
				
				
						Wei says:		

		
		
			June 11, 2017 at 9:46 pm		


		My experience, spent a lot time to figure this out:

It does NOT work if any of the PDF file has a single page. I tried many times dragging the documents to various places, but none worked. Note that when your PDF file has a single page, the whole PDF file is treated as just a PDF file in the thumnail; while in the multi-page scenario, each page is treated as an independent unit which you can drag around. In the former case, the single page PDF stay as a single page PDF which is not combined with the other pdf.

This must be a bug, or a stupid design.


		Reply

				

				



	
				
				
						parya olfati says:		

		
		
			March 17, 2017 at 5:38 am		


		thank you . so clearly explained .

Done :)


		Reply

				

				
	
				
				
						Jared says:		

		
		
			October 28, 2016 at 1:19 pm		


		I tried this, but it still only saves the one page that is currently selected, not the entire document.  Any other suggestions?


		Reply

				

				
	
				
				
						Mike H says:		

		
		
			April 14, 2016 at 1:47 pm		


		This worked fine for me. Yes the print pdf is a bit clunky but the article made it very clear that this was the way to do it so I went straight down this route and had no problem. However the choice of where to save the newly print created file is very clunky. No sidebar showing to speed up drilling down to where I wanted to save it. Wouldn’t you think it might guess I want to save to the same place as the first pdf that the rest got added into?


		Reply

				

					
				
				
						Mike H says:		

		
		
			April 16, 2016 at 6:11 am		


		Just to say that the sidebar missing from the print window turned out to be a universal problem. It was also missing from all of my save windows. 

Solution is very simple and can be found here: https://osxdaily.com/2016/03/05/fix-missing-sidebar-open-save-window-mac-os-x/#comment-2206281

Thanks OSX daily – my first port of call for trouble shooting every time.
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						Sean says:		

		
		
			February 8, 2016 at 9:21 pm		


		Hi, I can merger multiple PDFs by this method – but is there anyway of automatically putting page numbers in the merged final PDF?

Cheers

Sean


		Reply

				

				
	
				
				
						Jawad says:		

		
		
			December 19, 2015 at 4:04 am		


		Can we join Multiple pdfs having the specific phrase or word


		Reply

				

				
	
				
				
						Duder says:		

		
		
			December 5, 2015 at 5:19 am		


		Yeah this totally didn’t work for me, had to go via the Print PDF then save as a PDF. Clunky and frustrating but eventually worked.


		Reply

				

				
	
				
				
						Ar. Kifayat Hussain says:		

		
		
			November 26, 2015 at 11:06 pm		


		Thank you so much for this help and education. This is  working perfectly.


		Reply

				

				
	
				
				
						Bipul says:		

		
		
			November 2, 2015 at 11:52 am		


		I am on OS Yosemite 10.10.4. To save the pages as a single document, it does not work for with the save button or the export button. So, I used the brute force method of Print -> Save as PDF. That worked.


		Reply

				

				
	
				
				
						Lars Finsen says:		

		
		
			September 13, 2015 at 8:33 pm		


		It works for me, but oddly, when I have a mixture of portrait and landscape pages, the landscape ones are turned upside down. I have to turn each page in the landscape files upside down before I drag and drop them in order to get them right.
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						Jason says:		

		
		
			June 21, 2015 at 12:42 am		


		When I Export as PDF all I see is the first page and not the other 6, complete waste of time.
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						Justine says:		

		
		
			April 18, 2015 at 1:27 am		


		Quote “When finished adjusting, pull down the “File” menu and choose “Export as PDF” (normal saving does not work reliably to join the PDF files together, this is likely a bug)”

That should be written in 24 font at the very top of this article. I just lost an hour’s work scanning documents only to find that the “save” function is totally superficial. Even when I selected all of the docs in the sidebar, it only saved the very last doc.

Good luck everyone!
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						Ben says:		

		
		
			March 27, 2015 at 6:30 pm		


		I’ve just spent a half hour working this stupid problem out.

I found that yes, the instructions do work. But only if the files you are combining are already PDFs.

We wanted to combine multiple images (scans of full pages) into a single PDF but couldn’t get it to work. The steps we did were:

1. Open up the images into Preview and export them individually as PDFs.

2. Open each PDF into Preview

3. Follow the instructions above by opening up the thumbnail view and dragging each page onto the first page of the combined file. So by that I mean that you are dragging all subsequent files to the one, single page.

4. If/when it stops working, you need to view the pages within your new document in the sidebar. You’ll notice there’s a triangle which you can click and it will open and display all the pages combined. 

This is the tricky bit, because it’s not really clear what documents are going where. A thin grey line separates the documents. 

So open up the triangle and you’ll see your pages already combined. You should be able to now drag the other pages to that file and combine them. In the Preview window title, it should list how many documents you have and the pages within.

5. Once all pages are within, you can then select (in the sidebar) a page of the combined document and ‘Export as PDF’. Once saved, close all the windows and don’t bother to save.

6. Clean up all the single PDF files and images files (if you want), by dragging them to the trash.

Simples!
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						Linda says:		

		
		
			June 16, 2015 at 8:16 pm		


		Thank you, Ben.  This is the missing information and has saved my nonprofit organization some money and me some further hours and headaches.


		Reply

				

				



	
				
				
						Larissa says:		

		
		
			January 28, 2015 at 2:43 am		


		Just experienced a small problem and was able to fix it so thought I would share the solution in case anyone else comes across the same issue (I’m using Mountain Lion).

I dragged the files from Finder below the original PDF thumbnail, but when I would export the file to PDF, I only ever got the first single page. When highlighting each thumbnail individually, I would get the info “Page 1 of 1”, suggesting that I was just opening each file in the same window rather than actually combining them. I tried again by dragging the files from Finder on top of the thumbnail of the first PDF, or above it, and it worked! At that point all the thumbnails should be showing the same file name and there should be a grey bar underneath the last file. Exporting as a PDF was then successful.


		Reply

				

				
	
				
				
						John Starcher says:		

		
		
			December 10, 2014 at 9:25 am		


		Hi Everyone – 

I just thought I’d share – today is the first time I have tried combining PDF files since I upgraded to Yosemite.  I experienced the same problem as many of you – when “export to PDF” was attempted it only saved the highlighted thumbnail.   Through trial and error, I discovered that if I just “exported” the file, rather than “export as a PDF” it worked just fine!
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						Mike says:		

		
		
			July 20, 2014 at 6:18 pm		


		I too have been able to do this on regular occasions over the years but for some reason, today I am having no luck. 

Have reverted to the old fallback – print to PDF


		Reply

				

				
	
				
				
						Michael says:		

		
		
			July 3, 2014 at 6:58 pm		


		PDF Toolkit+ (available from the App Store) does this and more for just a few dollars.  I’ve used it and Preview for several years and find Preview clunky for combining PDFs.  It’s worth a couple of dollars to avoid struggling with Preview’s interface, IMO.


		Reply

				

				
	
				
				
						John Robinson says:		

		
		
			June 30, 2014 at 2:19 pm		


		NO JOY.

I’ve tried combining jogs into a pdf.

I’ve tried combining pdf’s into a pdf.

I’ve tried dragging ONLY thumbnails into.

I’ve tried dragging thumbnails onto the original.

I get multiple pages after dragging thumbnails, but after SAVE, there is only one page.

I get multiple pages after dragging thumbnails, but after EXPORT, there is only one page.

I’m using 10.9.4 in Mavericks, and this instructional is hogwash.


		Reply

				

					
				
				
						Wrong says:		

		
		
			June 30, 2014 at 2:26 pm		


		Wrong, this works. Interesting that every other commenter and myself can join multiple PDF files into a single PDF file and that you can’t, perhaps your inability to follow instructions is hogwash?


		Reply

				

				
	
				
				
						Paul says:		

		
		
			June 30, 2014 at 2:33 pm		


		Hi John,

I assure you this works to combine PDF files under Preview in OS X 10.9.4. As the guide states in step 5:

“When finished adjusting, pull down the “File” menu and choose “Export as PDF” (normal saving does not work reliably to join the PDF files together, this is likely a bug)”

There is a bug in some versions of Preview that may prevent saving as usual, thus you have to use “Export as PDF” or the “Print to PDF” function if you want all the PDF files to be combined into a single document. Why the bug only impacts some users but not others is not clear, it almost seems dependent on the input files instead, or perhaps how they are added. 

Anyway, I use this almost every day and I used it again today in 10.9.4 (and OS X 10.10 for that matter), it works perfectly to join PDF docs assuming the steps are followed as directed.


		Reply

				

					
				
				
						John Robinson says:		

		
		
			June 30, 2014 at 11:35 pm		


		The only way I found to do this per your suggestion clunkily is to Print to PDF.  If I try to Export, or Save as PDF, or Save As, or Export to PDF the ONLY thing I get is the item that is selected in thumbnails. There is no way I see to select all pages in thumbnails. There is no way to Unselect all pages in thumbnails. One page is ALWAYS selected in thumbnails, and that one page is exported or saved as. No matter if the header says there are multiple pages in the Preview Doc window. Preview will ignore all other pages except the selected page in thumbnail view and there is no way to select all pages that I can see in thumbnail view.

The trouble with Print to PDF is the default to 8.5 x 11 inches, so I must remember to reduce the image to to fit the letter size, or manually make a paper size to fit the images.

Its a hassle as I am used to Acrobat Pro simply combining a number of same size jpegs and pdfs into one pdf in a snap. I was hoping to drop the need for Acrobat Pro.

Ill try the above mentioned free app and see.


		Reply

				

					
				
				
						dee says:		

		
		
			October 15, 2014 at 12:11 pm		


		This is what I found after hours and hours of trying.

If you have one page that is portrait and another that is landscape,  “save” or “export to pdf” options don’t work. However, print to PDF works. Then you have to go back in it and flip the landscape pages around.


		Reply

				

				
	
				
				
						Rachel says:		

		
		
			December 31, 2014 at 6:43 am		


		No hogwash! I had the exact same problem! Over and over again.

I just tried it again, dropping the second file thumbnail on top of the first and then I didn’t touch either of them and neither was selected, so when I exported as PDF, it saved both of them together. Finally!! Not sure if how I dropped it had anything to do with it not selecting, but I know that once you select one, you can’t unselect, so the trick must be to get it saved before that happens.


		Reply

				

					
				
				
						Shankar K says:		

		
		
			January 8, 2015 at 12:59 pm		


		No hogwash for sure.  I had the exact same problem as above – tried all instructions exactly as above and in other sites, and export to pdf saved just 1 page, not all.  So I tried print and then saved as pdf, and it saved all the pages.


		
				

				









	
				
				
						Susan says:		

		
		
			March 16, 2015 at 12:48 pm		


		PROBLEM SOLVED!  I know this thread is old, but for others like me who stumble upon it, this might help.

I had the same issue – followed the instructions and it didn’t work.  Here’s what I found – when you drag the additional documents to the side bar, they have to be ABOVE the line that is under that document. Don’t add it below that line, add it above the line, within the same space as the first document.  When you add it correctly, the numbering on the pages should continue. For instance, I had a 2-page document, added another 2-page document.  When added to the space correctly, they numbered 1-4.  Otherwise they were numbered 1,2, then 1,2 again.

Hope that helps someone.


		Reply

				

					
				
				
						Ken says:		

		
		
			April 1, 2015 at 11:40 am		


		THANK YOU SUSAN!!


		Reply

				

				
	
				
				
						Molly says:		

		
		
			April 16, 2015 at 11:36 am		


		After many tries, the only way I got it to work was to use Print as PDF. Exporting only exported a single page, no matter what.


		Reply

				

					
				
				
						Nima says:		

		
		
			May 13, 2015 at 2:15 pm		


		Not sure if this will anyone but it helped me. Before when I tried to combine the files I would drag the thumbnails above or below the thumbnail from the other document I was trying to combine with. This creates two separate documents on one page. When you combine the thumbnails I noticed you have to drag it over the other thumbnail until a green plus sign shows up and this will combine the files. Then you can just save the file.
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						Stavro says:		

		
		
			May 27, 2015 at 3:31 pm		


		This worked for me, going to Print, and then ‘Save as PDF.’ I’m using 10.10.3. And I tried everything from above..there has to be bug with my version of Preview. Anyhow, thank you for your help Molly!
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						Emma says:		

		
		
			June 3, 2015 at 4:50 pm		


		I also had a same problem. I figured out. Only difference is that you have to drag the files on the top of the pdf file you just opened in tumbnails preview. So if you pay attention it creates triangle shape next to your first opened file. If you pay attention on image 6, there is a triangle shape next to the name “control cell data”, triangle faced down. I hope it helps to anyone who is struggling. Cheers!
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						Y-Guy says:		

		
		
			June 28, 2014 at 7:22 pm		


		If you can find a copy of the free app called iCombiner v1.5.0 it works in Mavericks and others and makes it a breeze to combine PDFs.
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						fusionfan says:		

		
		
			June 28, 2014 at 9:57 am		


		However, this method will “print” a new pdf file, so any pdf links are going to be destroyed.

You can use pdftk, a free tool, which will join pdf files while preserving and updating the links inside the new document.


		Reply

				

				
	
				
				
						Hobo says:		

		
		
			June 28, 2014 at 5:11 am		


		Works really well. I use it all the time. Like cashxx says to make a single document drag & drop the page on top of an existing page. To have a separate doc inside the one PDF drop it below the existing doc. A line will appear showing it is separate. The rest as above.


		Reply

				

				
	
				
				
						cashxx says:		

		
		
			June 27, 2014 at 7:20 pm		


		I think in newer versions of Preview you have to drag on top of the page you want your page to go after.  Drop it on the page, not the bare space like they show.

If that doesn’t work open both pdf’s in Preview, put them both in Thumbnails view and again take one page from the thumbnail of the other and drop it in the other document, but on the page like I said above, not on the space like they show.  

Should work, I just did this in Mavericks and combined about 20 pages.

I think you can even just hit save and it will save the document, but don’t quote me on that, I may have exported, I don’t recall now.  I know you can combine pdfs as I just did it last week.


		Reply

				

					
				
				
						Tiger says:		

		
		
			June 28, 2014 at 11:10 am		


		exactly :)


		Reply

				

				
	
				
				
						AJ says:		

		
		
			June 28, 2014 at 1:32 pm		


		You can just drag the PDF anywhere into the Drawer to “add” it as a new page(s), then re-drag them within the panel to adjust their order. It’s the same as what’s shown and described.

I do this often in Mavericks too, and it works in OS X Yosemite the same way.

And yes, for me anyway, you can just hit “Save” and the new document will save with the newly added PDF’s joined/combined into the original document. I suspect there’s a bug in some versions of Preview that would prevent that from occurring, but for me in OS X 10.9.3 and OS X 10.10, I can just hit ‘Save’ and the combined PDF file is generated as expected. 

BTW this also works with encrypted PDF’s as long as they have write access and aren’t copy/write protected from Acrobat.
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						Roger says:		

		
		
			January 13, 2015 at 4:50 pm		


		cashxx, thank you!!!  This has been frustrating me for months (I upgraded to Yosemite in October), and finally I ran into you explanation.  It worked like a charm…..


		Reply

				

				



	
				
				
						Craig says:		

		
		
			June 27, 2014 at 4:46 pm		


		Tried this but it didn’t work. When I dragged the PDF file from the Finder to the Thumbnails, it just bounced back. Also tried Deleting a page from a multi-page document by hitting the Delete key and that didn’t work either.


		Reply

				

					
				
				
						Tiger says:		

		
		
			June 28, 2014 at 11:09 am		


		i do it for years, works perfect!
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						Jill says:		

		
		
			November 5, 2014 at 10:30 am		


		Craig and Tiger,  I have used Preview successfully for a number of months and it has been wonderful… very dependable.  But when I upgraded to Yosemite, I began having the same problems as you, Craig.  I have spent quite a few hours with senior advisors at Apple Care with this issue, as I need this software option for my work, and finally my files have been sent to the Apple engineers.  I am hoping they will be able to work this out, as the Preview software is really quite nice when it works.
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						Rhiannon says:		

		
		
			December 21, 2014 at 11:25 pm		


		I cannot get mine to merge at all now and I have spent an hour trying to get it to work.  This is so annoying!  I would love to know when the issue has been resolved.
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